
 

VnetPC 2007 
 

 

USER'S MANUAL & 

TUTORIAL  
 
 

 
 
 

Mine Ventilation Services, Inc. 
1625 Shaw Ave #103 

Clovis, CA 93611 
USA 

 
Tel: 1-559-452-0182 
Fax: 1-559-452-0184 

E-mail: support@mvsengineering.com 
Internet: www.mvsengineering.com 

 
 

 

mailto:support@mvsengineering.com
http://www.mvsengineering.com/


 ii 

Table of Contents 
 

1. INTRODUCTION .............................................................................................................................................. 1 

2. OVERVIEW OF VNETPC ............................................................................................................................... 2 
2.1 VNETPC: ITS APPLICATIONS AND USES ...................................................................................................... 2 
2.2 BACKGROUND THEORY OF VNETPC ........................................................................................................... 2 
2.3 LIST OF MAIN PROGRAM FEATURES ............................................................................................................ 2 
2.4 SYSTEM REQUIREMENTS OF VNETPC.......................................................................................................... 3 
2.5 SETUP PROCEDURE ...................................................................................................................................... 3 
2.6 SOFTWARE ENCRYPTION ............................................................................................................................. 6 

3. DATA PREPARATION AND INPUT ............................................................................................................. 7 
3.1 VENTILATION NETWORK (SCHEMATIC) ....................................................................................................... 7 

3.1.1 Closed Circuit ........................................................................................................................................ 7 
3.1.2 Junction Numbers .................................................................................................................................. 8 
3.1.3 Schematic Layout ................................................................................................................................... 8 

3.1.3.1 Scaling and Offset of Coordinates during DXF import ................................................................................ 8 
3.1.4 Parallel Branches .................................................................................................................................. 8 

3.1.4.1 Parallel Branch Tool .................................................................................................................................... 8 
3.2 DESCRIPTIVE DATA ..................................................................................................................................... 9 

3.2.1 File Name............................................................................................................................................. 10 
3.2.2 Units and Conversion Utility ............................................................................................................... 10 
3.2.3 Power Cost........................................................................................................................................... 10 
3.2.4 Air Density and Regulator Sizing ........................................................................................................ 10 
3.2.5 Notepad (Comments) ........................................................................................................................... 10 

3.3 BRANCH DATA .......................................................................................................................................... 11 
3.3.1 Branch Data Formats .......................................................................................................................... 11 

3.3.1.1 Resistance Data .......................................................................................................................................... 13 
3.3.1.2 p and Q Data .............................................................................................................................................. 13 
3.3.1.3 k, L, Leq, A, Per Data ................................................................................................................................. 13 
3.3.1.4 Resistance per Length Data Form .............................................................................................................. 14 
3.3.1.5 Automatic Length Tool .............................................................................................................................. 15 

3.3.2 Branch Input View ............................................................................................................................... 16 
3.3.3 Schematic View .................................................................................................................................... 17 

3.3.3.1 Levels and Perspective ............................................................................................................................... 20 
3.3.3.2 Grids and Snap to Grid ............................................................................... Error! Bookmark not defined. 
3.3.3.3 Junction Creation ........................................................................................ Error! Bookmark not defined. 
3.3.3.4 Importing DXF Files from CAD and Mine Planning Programs .................. Error! Bookmark not defined. 
3.3.3.5 Surface State ............................................................................................... Error! Bookmark not defined. 
3.3.3.6 Branch Code ............................................................................................... Error! Bookmark not defined. 

3.4 FAN DATA ........................................................................................... ERROR! BOOKMARK NOT DEFINED. 
3.4.1 Fan Location and Flow Direction ......................................................... Error! Bookmark not defined. 
3.4.2 Fan Type ................................................................................................ Error! Bookmark not defined. 
3.4.3 Fan File Manager .................................................................................. Error! Bookmark not defined. 

3.4.3.1 Creating a Fan Curve Data Base ................................................................. Error! Bookmark not defined. 
3.4.3.2 Importing a fan curve into a model ............................................................. Error! Bookmark not defined. 
3.4.3.3 Saving a fan curve from a model, into the Fan Curve Data Base ................ Error! Bookmark not defined. 

3.5 FIXED QUANTITY TOOL ....................................................................... ERROR! BOOKMARK NOT DEFINED. 
3.6 CONTAMINANT DISTRIBUTION ANALYSIS DATA ................................. ERROR! BOOKMARK NOT DEFINED. 

4. OPERATING THE PROGRAM ..................................................... ERROR! BOOKMARK NOT DEFINED. 
4.1 MANAGE NETWORK FILES .................................................................. ERROR! BOOKMARK NOT DEFINED. 
4.2 DATA CONVERSION – PREVIOUS VNETPC VERSIONS .......................... ERROR! BOOKMARK NOT DEFINED. 
4.3 EXECUTE VENTILATION SIMULATION ................................................. ERROR! BOOKMARK NOT DEFINED. 



 iii 

4.4 VIEWING THE RESULTS OF A SIMULATION .......................................... ERROR! BOOKMARK NOT DEFINED. 
4.4.1 List Errors .............................................................................................. Error! Bookmark not defined. 

4.4.1.1 Too Many Fixed Quantities ........................................................................ Error! Bookmark not defined. 
4.4.1.2 Branch Omitted in Mesh Selection ............................................................. Error! Bookmark not defined. 
4.4.1.3 No Mesh Found for Branch ........................................................................ Error! Bookmark not defined. 
4.4.1.4 Iteration Limit Exceeded ............................................................................. Error! Bookmark not defined. 

4.4.2 Fan Operating Points ............................................................................ Error! Bookmark not defined. 
4.4.3 Branch Results ....................................................................................... Error! Bookmark not defined. 
4.4.4 Fixed Quantity Information ................................................................... Error! Bookmark not defined. 
4.4.5 Displaying the Results using the Schematic ........................................... Error! Bookmark not defined. 

4.4.5.1 Preferences Menu ....................................................................................... Error! Bookmark not defined. 
4.4.5.2 Zoom Menu ................................................................................................ Error! Bookmark not defined. 
4.4.5.3 Junction Data .............................................................................................. Error! Bookmark not defined. 
4.4.5.4 Ventilation Structure Symbols .................................................................... Error! Bookmark not defined. 

4.4.6 Printing Output Data ............................................................................. Error! Bookmark not defined. 
4.4.7 Plotting Output Data ............................................................................. Error! Bookmark not defined. 
4.4.8 DXF File Generation ............................................................................. Error! Bookmark not defined. 

4.5 CHANGING THE APPEARANCE OF A TABLE VIEW ................................ ERROR! BOOKMARK NOT DEFINED. 
5. TUTORIAL ....................................................................................... ERROR! BOOKMARK NOT DEFINED. 

5.1 INTRODUCTION .................................................................................... ERROR! BOOKMARK NOT DEFINED. 
5.2 SETTING UP THE MODEL IN AUTOCAD .............................................. ERROR! BOOKMARK NOT DEFINED. 

5.2.1 Adding the Ventilation Layers ............................................................... Error! Bookmark not defined. 
5.2.2 Drawing the Schematic (Line Diagram) ................................................ Error! Bookmark not defined. 
5.2.3 Exporting the DXF File ......................................................................... Error! Bookmark not defined. 

5.3 WORKING IN THE VNETPC PROGRAM ................................................. ERROR! BOOKMARK NOT DEFINED. 
5.3.1 Model Information View ........................................................................ Error! Bookmark not defined. 
5.3.2 Schematic View ...................................................................................... Error! Bookmark not defined. 

5.3.2.1 Importing the Schematic ............................................................................. Error! Bookmark not defined. 
5.3.2.2 Defining Group Attributes .......................................................................... Error! Bookmark not defined. 
5.3.2.3 Viewing the Model Cross-Section .............................................................. Error! Bookmark not defined. 
5.3.2.4 Viewing the Schematic in 3D ..................................................................... Error! Bookmark not defined. 

5.4 ADDING BRANCHES TO THE SCHEMATIC ............................................. ERROR! BOOKMARK NOT DEFINED. 
5.5 DEFINING BRANCH ATTRIBUTES (RESISTANCES) ................................ ERROR! BOOKMARK NOT DEFINED. 
5.6 INSERTING FANS AND FIXED QUANTITIES ........................................... ERROR! BOOKMARK NOT DEFINED. 
5.7 ADDING A CONTAMINANT ................................................................... ERROR! BOOKMARK NOT DEFINED. 
5.8 PROGRAM EXECUTION ........................................................................ ERROR! BOOKMARK NOT DEFINED. 

6. APPENDIX: TOOLS AND TOOL BUTTONS .............................. ERROR! BOOKMARK NOT DEFINED. 
 



 iv 

List of Figures 
 

FIGURE 1: NEW MODEL ............................................................................................................................................... 5 
FIGURE 2: UNIT SELECTION DIALOG BOX ................................................................................................................... 5 
FIGURE 3: MODEL INFORMATION VIEW ...................................................................................................................... 9 
FIGURE 4: BRANCH INPUT VIEW ................................................................................................................................ 11 
FIGURE 5: BRANCH INFORMATION DIALOG BOX ....................................................................................................... 12 
FIGURE 6: FRICTION FACTOR DIALOG BOX ............................................................................................................... 14 
FIGURE 7: RESISTANCE PER LENGTH VALUES DIALOG BOX ...................................................................................... 15 
FIGURE 8: AUTOMATIC BRANCH LENGTH DIALOG BOX ............................................................................................ 16 
FIGURE 9: BRANCH INPUT VIEW ................................................................................................................................ 17 
FIGURE 10: EXAMPLE AIRWAYS. ............................................................................................................................... 18 
FIGURE 11: CREATE FAN DIALOG BOX ..................................................................................................................... 19 
FIGURE 12: BRANCH CONTAMINANTS DIALOG BOX ................................................................................................. 19 
FIGURE 13: EDIT LABEL DIALOG BOX ....................................................................................................................... 20 
FIGURE 14: BRANCH GROUPS DIALOG BOX ........................................................ ERROR! BOOKMARK NOT DEFINED. 
FIGURE 15: 3D VIEW OF A METAL MINE WITH 3D SPIN TOOL ACTIVE ............... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 16: CROSS SECTION VIEW OF A METAL MINE......................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 17: ACTIVE GROUP DROP DOWN MENU ................................................. ERROR! BOOKMARK NOT DEFINED. 
FIGURE 18: DXF IMPORT - LAYER SELECTION .................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 19: FAN DATA DIALOG BOX ................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 20: FAN CURVE DIALOG BOX ................................................................. ERROR! BOOKMARK NOT DEFINED. 
FIGURE 21: FAN INPUT VIEW............................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 22: FAN RESULTS VIEW .......................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 23: NEW FAN CURVE FILE ...................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 24: BRANCH INPUT FIXED QUANTITY VIEW ........................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 25: SCHEMATIC VIEW FIX QUANTITY ..................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 26: CONTAMINANT DATA VIEW ............................................................. ERROR! BOOKMARK NOT DEFINED. 
FIGURE 27: VIEW ERRORS DIALOG BOX ............................................................. ERROR! BOOKMARK NOT DEFINED. 
FIGURE 28: BRANCH RESULTS VIEW ................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 29: JUNCTION DATA VIEW ...................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 30: DXF SELECT INFORMATION DIALOG BOX ........................................ ERROR! BOOKMARK NOT DEFINED. 
FIGURE 31: COLUMNS DIALOG BOX FOR BRANCH INPUT VIEW .......................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 32: AUTOCADTM LAYER PROPERTIES MANAGER DIALOG BOX - COPIED FROM AUTOCAD 2000TM .. ERROR! 

BOOKMARK NOT DEFINED. 
FIGURE 33: DRAWING OF METAL MINE AIRWAYS (PLAN VIEW WITH ALL LEVELS)ERROR! BOOKMARK NOT 

DEFINED. 
FIGURE 34: 3120 LEVEL ...................................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 35: 3120 LEVEL WITH WIRE FRAME DRAWN .......................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 36: 2980 LEVEL WITH WIRE FRAME DRAWN .......................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 37: 2840 LEVEL WITH WIRE FRAME DRAWN .......................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 38: 2700 LEVEL WITH WIRE FRAME DRAWN .......................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 39: CLOSE-UP OF BRANCHES DRAWN IN RAMP ...................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 40: ENSURE ALL BRANCHES ARE TRULY CONNECTED ............................ ERROR! BOOKMARK NOT DEFINED. 
FIGURE 41: 3120 GROUP ..................................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 42: 2980 GROUP ..................................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 43: 2840 GROUP ..................................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 44: 2700 GROUP ..................................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 45: RAMP GROUP .................................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 46: AUTOCADTM SAVE DRAWING AS DIALOG BOX............................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 47: VNETPC NEW MODEL DIALOG BOX ................................................. ERROR! BOOKMARK NOT DEFINED. 
FIGURE 48: SELECT UNITS DIALOG BOX ............................................................. ERROR! BOOKMARK NOT DEFINED. 
FIGURE 49: MODEL INFORMATION VIEW ............................................................ ERROR! BOOKMARK NOT DEFINED. 
FIGURE 50: IMPORTING THE DXF FILE INTO VNETPC ......................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 51: LAYER SELECTION DIALOG BOX ...................................................... ERROR! BOOKMARK NOT DEFINED. 



 v 

FIGURE 52: PLAN VIEW OF IMPORTED SCHEMATIC ............................................. ERROR! BOOKMARK NOT DEFINED. 
FIGURE 53: JUNCTION GROUPS DIALOG BOX ...................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 54: EDIT JUNCTION DIALOG BOX ........................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 55: COMPLETED CROSS-SECTIONAL VIEW OF SCHEMATIC ..................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 56: ROTATED 3D SCHEMATIC ................................................................. ERROR! BOOKMARK NOT DEFINED. 
FIGURE 57: DRAWING BRANCHES IN SCHEMATIC CROSS-SECTION ..................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 58:  DISPLAYING A SINGLE GROUP (LEVEL) ........................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 59:  INSERTING A JUNCTION .................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 60:  BRANCH DATA DIALOG BOX ........................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 61: AUTOMATIC BRANCH LENGTH CALCULATION DIALOG BOX ............ ERROR! BOOKMARK NOT DEFINED. 
FIGURE 62: FAN OR FIXED QUANTITY DIALOG BOX ........................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 63: FAN DATA DIALOG BOX ................................................................... ERROR! BOOKMARK NOT DEFINED. 
FIGURE 64: FAN CURVE DIALOG BOX ................................................................. ERROR! BOOKMARK NOT DEFINED. 
FIGURE 65:  CONTAMINANT DIALOG BOX ........................................................... ERROR! BOOKMARK NOT DEFINED. 



 vi 

List of Tables 
 

TABLE 1 - BRANCH DATA TYPES ............................................................................................................................... 12 
 
 

List of Equations 
 

EQUATION 1:    2Q
pR =  ................................................................................................................................. 13 

EQUATION 2:     3

)(
cA

PLLk
R ereq+
=  ............................................................................................................... 13 

 



 1 

 

1. Introduction 
 
Welcome to VnetPC 2007. This latest upgrade of the popular ventilation simulation program 
combines the power of full 32-bit screen graphics with the proven VnetPC code. This program 
continues to be designed by practicing ventilation engineers. Credit for many of the new features 
goes to the hundreds of users in the mining and tunneling industries throughout the world. 
 
The applicability of VnetPC to subsurface ventilation system design ranges from the initial 
concept through to the system operations phase of a project. Given information that describes the 
geometry of a ventilation network, airway resistances or dimensions, and the locations and 
characteristic curves of fans, the code will produce listings and visual graphics of many 
parameters. The output includes predicted airflows, frictional pressure drops, air power losses in 
airways, contaminant flows and concentrations, and fan operating points. 
 
VnetPC has been developed specifically for computers operating under the Windows 
environment. The system is supplied on one CD-ROM. Data files and fan databases prepared 
using the previous version of VnetPC 2000 can be imported and converted for use with the latest 
program. 
 
Prior to installing the software, it is recommended that the user become familiar with this User’s 
Manual. This manual provides an overview of the VnetPC package and software encryption 
routine that is recommended for both new users, and for users of previous versions. 
Comprehensive Help Menus are included with the program to further assist users in 
understanding how the program works. To access the Help Menu, click on the Help Menu above 
the tool bar. A tutorial section is included with this manual, which provides a quick-start to 
developing ventilation networks. 
 
If you have any questions or comments regarding VnetPC please do not hesitate to contact us. 
Mine Ventilation Services, Inc. (MVS) maintains a comprehensive web site, which includes up-
to-date information on VnetPC. We also offer free technical support to all users of the latest 
version of the VnetPC program. Thank you for choosing the VnetPC software program, and for 
supporting the continued development of the code. 
 

Mine Ventilation Services, Inc. 
4946 East Yale Ave., Suite 103 
Fresno, California  93727 
United States of America 
 
Telephone: 1-559-452-0182 
Facsimile: 1-559-452-0184 
E-mail:  support@mvsengineering.com 
Internet:  www.mvsengineering.com 

 

mailto:support@mvsengineering.com
http://www.mvsengineering.com/
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2. Overview of VnetPC 
 
The VnetPC program is designed to assist the mine ventilation practitioner in the planning and 
monitoring of underground ventilation layouts. Given data that describes the geometry of the 
mine network, airway resistances or dimensions, and the location and characteristic curves of 
fans, the program will provide graphical and tabular representations of various predicted 
ventilation parameters. 
 

2.1 VnetPC: Its Applications and Uses 
 
VnetPC can simulate existing ventilation networks such that fan operating points, airflow 
quantities, and frictional pressure drops approximate those of the actual system. This is 
accomplished using data from ventilation surveys together with information determined from 
known airway dimensions and characteristics. Proposed subsurface facilities may also be 
designed using VnetPC. Such simulations are conducted by incorporating physical input data 
from conceptual plans with documented design parameters used to determine estimated 
resistances for airways in the network. The range of fan duties required, airflows, pressure drops, 
operating costs, and the location of ventilation controls may be ascertained for the entire life of a 
project by conducting time-phase exercises. Options within VnetPC allow for the display and 
manipulation of three-dimensional networks, production of listings and output files, and plots of 
input and output data. 
 

2.2 Background Theory of VnetPC 
 
The VnetPC program has been developed with the assumption of incompressible flow and is 
based on Kirchhoff's Laws. The code utilizes an accelerated form of the Hardy Cross iterative 
technique to converge to a solution. 
 

2.3 List of Main Program Features 
 
• Full-color, interactive 3D network schematic 
• Enhanced, expandable coordinate system 
• Data input and output via the Schematic or tabular views 
• Color coding of branches for airway type (user defined) 
• Import DXF files from CAD and mine planning programs 
• Ability to enter series and parallel arrangements for fans 
• Imperial and SI units with full data conversion 
• Automatic allocation of surface branches to close meshes around surface nodes 
• Notepad to enter detailed description of simulation 
• Full annotation capabilities in all views - allows angled text 
• Automatic calculation of branch length from coordinate values 
• Regulator orifice sizing tool 
• Pure 32-Bit application with rapid execution times 
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• Default network size limit is 5,000 branches with 600 fans 
• Extensive Help Tools and Tutorials 
• Full online support at www.mvsengineering.com 
• Direct graphic printing and multi-colored plotting 
• Export DXF files to CAD and mine planning programs – attribute exported specifically 

chosen 
• Four input data types for branch resistance 
• Steady state contaminant distribution analyses 
• Fixed quantity tool 
• Color coding of branches for range of parameter (airflow, pressure, etc.) 
• Cut/copy/paste features for data exchange within Windows 
• Variable frequency drives – fan curve adjustments for density and frequency (RPM) 
• Edit branches in multiple views 
 

2.4 System Requirements of VnetPC 
 
• IBM Compatible Computer running Windows 95, 98, 2000, NT, XP or Vista 
• Pentium class processor or above 
• 16 MB RAM Memory 
• 50 MB Hard Disk Space for the VnetPC program (additional for Adobe Acrobat ReaderTM) 
• VGA Display 
 

2.5 Setup Procedure 
 
The VnetPC program is shipped as a single installation file on a CD-ROM (VnetPC 2007 
Setup.EXE).  The following installation instructions will assist you in achieving a trouble-free 
installation, regardless of what operation software you are using, or whether or not you already 
have a version of VnetPC installed on you machine.  Please note that there is an additional setup 
file for installing the network version on a server.  
 

1. Insert VnetPC 2007 distribution disk into the reader and execute the self-installing utility 
program from VnetPC 2007 Setup.exe. 

 
This will create a directory – C:\Program Files\VnetPC 2007\ or other as specified by the 
user. 
 
The installation process creates the directory, and inserts the associated program and 
ancillary files. 
 

2. When the installation wizard is complete, there should be a short cut on the desktop to 
install the HASP device drivers.  Click on the short cut to begin the process of installing 
the HASP device drives.   

 
The set of drivers that will be installed are the latest available at the time that the install 
file was developed. 
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3. Determine if you need to install MSJET 3.5 drivers: 

 
Are you running Windows XP or Windows 2000? 
 
No.  If you are running Windows 98SE you should already have MSJET 3.5 installed. 
 
Yes.  Is this a native installation? 
 
No, I upgraded from Windows 98SE.  You should already have MSJET 3.5 installed. 
 
Yes, the computer came with Windows XP/2000 as the original operating system.  It 
is recommended that you install the MSJET 3.5 before continuing.   
 

4. If you answered yes to both question in step 3.   
 

Go to the directory C:\Program Files\VnetPC 2007\ (or directory, if you changed the 
default). 
 
Find the compressed folder JET.ZIP and extract the three folders that are contained. 
 
Switch to the extracted folder “DISK 1” and execute the setup.exe installation wizard. 
 
In the first dialog box, select the option to install MSJET 3.5 only, unselect ODBC. 
 
In the second dialog box, unselect ALL of the associations.   
 

5. Now, ensure that the HASP device driver is properly attached to the computer in a USB 
port or Parallel port as appropriate. 
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6. Click on the shortcut to start VnetPC 2007 program. 
 

a. The program should open. 
b. Use the FileNewVnetPC 2007 File sequence to open a new model illustrated 

in Figure 1.  
 

 
Figure 1: New Model 

 
c. Next a dialog box should appear, as shown below in Figure 2, requesting you to 

select the system of units for this model.  Select units desired for your model and 
press “OK”.   

 

 
Figure 2: Unit Selection Dialog Box 
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d. If you get an Untitled – Model Information dialog box, the program and the 

associated support programs are installed correctly. 
 
Congratulations!!  You can now begin using VnetPC 2007 ventilation simulation program. 
 
If the VnetPC 2007 program window does not open, but you get a HASP not found (x) error 
please verify: 
 
HASP not found (0) – that the HASP device is properly attached to the computer (on a USB 
HASP the red light in the device should be on).  
 
If the VnetPC 2007 program window open but the program crashes when you try to start a new 
file, or open and existing one, verify that the MSJET 3.5 drivers are properly installed.  If you 
need to install these, make sure that you unselect all of the default associations or you MS-
OFFICE suite may not function correctly.   
 
These are the common problems encountered during installation. 
 
Now, that the program is functioning, check the version number: 
 HelpAbout Vnetwin 
 
Then check for updates and patches: 
 
www.mvsengineering.com/download.htm 
 
If the patch has a higher version alpha-numeric than shows up in the help about information 
panel, then you may download the patch. 
 
Simply Save Target to your program directory and then extract the replacement *.exe and *.dll 
files to over-right the existing version.  Note that if you try to move old version as a back up you 
will need to make sure that you manually verify the short cuts.  Windows may keep track of 
where the old files have been relocated. 
 
If you have any further questions with regard to the installation process, or the operation of this 
or other MVS software, please feel free to contact us by telephone: 1-559-452-0182 or by email: 
support@mvsengineering.com.  
 

2.6 Software Encryption 
 
The VnetPC program is protected by a software hardlock (HASP).  The hardlock device is 
installed on a USB port or a Parallel port of the computer, or server (net-HASP).  After the 
VnetPC program is installed, the hardlock device drivers must be installed.  For the single user 
version of VnetPC 2007, the driver installation routine will be located in the default VnetPC 
2007 directory, for the multi-user version of the program the driver installation routine will be 
located in a separate “net-HASP license manager” directory. 

http://www.mvsengineering.com/download.htm
mailto:support@mvsengineering.com
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If any problems are encountered please contact MVS.  MVS can be reached at; phone (559) 452 
0182, fax (559) 452 0184, or e-mail at MVS at support@mvsengineering.com. 
 

3. Data Preparation and Input 
 
VnetPC is structured such that the user moves between views, or windows, where input and 
output data are located. A single file is used for the network input, schematic coordinates, and 
contaminant data. A separate archive file is used to store multiple fan curves. Creating, 
importing, editing, or viewing fan curves are performed within the VnetPC program. The 
VnetPC program comprises nine screens for the input and display of program data. The screens 
are listed on the Menu Bar under the “Go To” Menu. These views are: 
 
• Model Information 
• Branch Input  
• Branch Results 
• Fixed Quantities 
• Fan Input 
• Fan Results 
• Junction Data 
• Schematic 
• Contaminants 
 
This section details the content and form of the input data required for the VnetPC program. The 
data requirements are presented in six categories: 
 
1. Ventilation Network  (page 7) 
2. Descriptive Data    (page 9) 
3. Branch Data   (page 11) 
4. Fan Data     (page Error! Bookmark not defined.) 
5. Fixed Quantity Tool   (page Error! Bookmark not defined.) 
6. Contaminant Distribution Data  (page Error! Bookmark not defined.) 
 

3.1 Ventilation Network (Schematic) 
 
A ventilation network is a graphical representation of a ventilation system and consists of a set of 
junctions and interconnecting lines (branches) which denote major or significant airflow routes. 
The following subsections describe the schematic requirements. 
 
3.1.1 Closed Circuit 
 
The network schematic must form a closed circuit of interconnected branches. Each branch 
should represent a single airway, a group of airways, or leakage paths. VnetPC will 
automatically close those branches connected to the surface, as long as the user specifies them as 
being either "Surface Intake" or "Surface Exhaust" branches. There are options to select the 

mailto:support@mvsengineering.com
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surface state of the various network branches in both the Schematic and Branch Input Views 
(refer to Section 3.3.3.5). 
 
3.1.2 Junction Numbers 
 
Junction numbers must be assigned to each junction in the schematic. Valid numbers are whole 
integers from 1 to 9999. VnetPC is capable of selective viewing and printing of branches 
interconnected to any specified range of junction numbers. VnetPC will automatically allocate 
junction numbers for new branches drawn in the Schematic View or for imported data from a 
DXF file. 
 
3.1.3 Schematic Layout 
 
Three techniques can be used to enter the schematic into VnetPC: 
 
1. Draw the schematic in a CAD or mine planning program (established as a unique layer, 

perhaps called VnetPC) and import to VnetPC. This method is typically adopted when the 
user wants to drape/overlay the ventilation network on a mine plan (within a CAD program). 

2. Directly plot the network on the screen using the system mouse (acceptable for smaller 
networks). 

3. Numerically enter the coordinate data in tabular form, or copy the coordinate data from a 
spreadsheet and paste into the Junction Data View. 

 
Note: Scaling and Offset of Coordinates during DXF import 
 
VnetPC supports real-world coordinates, and will generally import exact coordinates from CAD 
programs. The exception is when the program has to apply an offset to the imported data, and/or 
scales the network because the coordinate range is too great for the VnetPC views. Any scaling 
or offset is identified to the user during the importing process. For importing multiple layers or 
DXF files into the same network, the initial offset and scaling information (used for the first 
layer) will automatically be applied to all subsequently layers. 
 
3.1.4 Parallel Branches 
 
User's experienced with previous versions of VnetPC have indicated that confusion can arise if 
two or more branches are entered with identical From and To junction numbers. VnetPC checks 
for this condition during data entry and will not allow duplicate branches. However the user can 
effectively connect any two junctions with parallel branches by either reversing the junction 
numbers or inserting intermediate nodes. 
 
Note: Parallel Branch Tool 
 
A new tool exists to allow the user to rapidly adjust the resistance of a branch according to 
parallel network theory. This tool is accessible in both the Branch Input View (column) and the 
Schematic View (Branch Data dialog box). The user may enter a number, with the default being 
1. If the user selects a 2, then the code will adjust the input branch resistance to double the 
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number of airways represented by the branch. If the user were to enter 0.5, then the resistance 
would be adjusted to give half the number of airways represented in the branch. If the user enters 
1, then the resistance is reset to the original value.  During ventilation survey resistances are 
determined for parallel entries and are input directly to the model.  Although only one branch is 
modeled it will actually represent two (sometimes three) parallel entries.  Care should be taken to 
identify exactly how many entries are incorporated into the original resistance value. 
 

3.2 Descriptive Data 
 
Descriptive data consists of both required and optional information for documentation and 
program initiation. The descriptive information is modified in the Model Information View. The 
Model Information View allows data to be directly entered into cells. Figure 3 shows the Model 
Information View. 
 

 
Figure 3: Model Information View 

 
The following subsections describe the input and required format for the data in the Model 
Information View. 
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3.2.1 File Name 
 
A file name must be assigned when saving the file for the first time, or when utilizing the “Save 
As” command under the File Menu. When a file is saved, the program automatically prompts for 
the extension .vdb. VnetPC supports extended file names. 
 
3.2.2 Units and Conversion Utility 
 
VnetPC supports both Imperial and SI units. The user must initially specify one type of 
engineering unit; however, should the user decide to change units, then an automatic conversion 
feature is available. This conversion feature is available from the Tools Menu in any view. The 
conversion utility converts all the input data including the fan curves. It is important that the user 
executes the program following unit conversion. In rare cases, during conversion, one or more 
data values may become out of range, and the program will truncate the values. However, this 
will only occur if the original network contains extremely high input parameters, and the 
truncated values should still be sufficiently large so that the network accuracy is not impacted. 
 
3.2.3 Power Cost 
 
The user should enter an electrical power cost to determine the operating cost for the system 
fans. Power costs are provided in units/kWh, where the unit may be any currency. 
 
3.2.4 Air Density and Regulator Sizing 
 
The user is required to input an average air density for the underground. This value is needed to 
compute the orifice area for any regulators listed in the Fixed Quantity View. The air density 
parameter is not used anywhere else in the program. 
 
3.2.5 Notepad (Comments) 
 
There is a large text field available to enter a detailed description of the particular file. 
Information may include a title, summary of results, and the specific details associated with that 
model. This Notepad is seen in the Model Information View. Text may be entered directly in the 
reduced window, or the Notepad may be maximized by pressing the Edit key. 
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3.3 Branch Data 
 
3.3.1 Branch Data Formats 
 
VnetPC recognizes four branch data formats. The available branch types may be accessed in the 
Branch Input View from a drop-down list under the appropriate column for each branch shown 
in Figure 4.  
 

 
Figure 4: Branch Input View 

 
A feature also exists that links a numerical code to the resistance data options. If the user is 
entering data into the Branch Input View using the number pad on a keyboard, then to facilitate 
rapid data entry a code of 1, 2, 3 or 4 may be used (see Table 1).  
 
Branch data types can also be entered in the Schematic View using the Selection Pointer or the 
Edit tool.  The Selection Pointer is located under the drop down menu Tools or by selecting the 
Selection Pointer icon  on the Tool Bar and pressing the right mouse button (select the Branch 
Data option).  The Edit tool can be selected in the Tools drop down menu or by selecting the Edit 
tool icon  located on the Tool Bar and pressing the left mouse button on the branch.  Using 
any of these methods the following Branch Data dialog box, illustrated in Figure 5, will appear 
where branch types can also be changed.      
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Figure 5: Branch Information Dialog Box 

 
Each branch is defined by two junctions and by numerical data that indicate the characteristics of 
the airway (see Figure 5). Data may be entered in any of the four formats shown in Table 1. The 
mouse can be used to copy and paste ranges of data between branches in the Branch Input View 
or from other Windows applications (such as spreadsheets or other ventilation simulators).  Once 
data is entered into the program the data will be always be there until deleted.  The resistance 
type can be changed so that different parameters can be used to define the resistance, but the 
original data will be saved, it will just not be active. 
 
Table 1 - Branch Data Types 

Data Type Entry Form Comments 
1 R (airway resistance) Fixed resistance 
2 p, Q (frictional pressure drop and quantity) Pressure drop - volume data 
3 k, L, Leq, A, Per (friction factor, length, 

equivalent length, area and perimeter) 
Required input for Atkinson’s 
Equation 

4 R/Length, L, Leq (resistance per unit 
length, airway length and equivalent 
length)  

Allows direct calculation of 
resistance from previously 
measured resistance 
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A detailed description of the four data entry formats is described in the following sections. 
 
3.3.1.1 Resistance Data 
 
Data type 1 requires that a resistance value be input for the branch. This data type is useful for 
branches with a known or previously computed resistance. When a new branch is input in either 
the Branch Input or Schematic views the default branch data type is 1. When a network is 
developed from an imported .DXF file, the branch type will default to type 1, with a preset 
resistance of zero. 
 
3.3.1.2 p and Q Data 
 
Data type 2 requires pressure and quantity to be input. These values are usually obtained from a 
pressure-quantity survey. The program calculates the resistance, R, on the basis of the Square 
Law, as given below: 
 

Equation 1:    2Q
pR =        

 
Where:  R = airway resistance (Practical Unit [P.U.] or Ns2/m8) 
  p = pressure drop (milli inch w.g. or Pa) 
  Q = flow rate (kcfm [× 1000 cfm] or m3/s) 
 
3.3.1.3 k, L, Leq, A, Per Data 
 
Data type 3 requires the physical characteristics of the airway to be input (Atkinson friction 
factor (k-factor), length, equivalent length of shock loss, perimeter, and cross-sectional area). 
This data type computes branch resistance empirically. The program calculates the resistance 
from Atkinson's equation, expressed below: 
 

Equation 2:     3

)(
cA

PLLk
R ereq+
=       

 
Where:  R = airway resistance (Practical Unit or Ns2/m8) 
  k = friction factor (lbf min2/ft4×10-10 or kg/m3) 
  L = length of airway (ft or m) 
  Leq = equivalent length of shock loss (ft or m) 
  A = area (ft2 or m2) 
  Per = perimeter of airway (ft or m) 
  c = constant (Imperial = 52 and SI = 1) 
 
VnetPC verifies each entry as it is input and, if invalid, requests re-entry. It should be noted 
when inputting a value for k factor in Imperial Units into the Branch Data; the 10-10 factor must 
not be included in the entry. Hence, for a typical airway with a k factor of 65 ×10-10 lbf min2/ft4, 
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the user would enter only 65. Note that VnetPC uses a constant of 52 not 5.2. This allows the 
Atkinson friction factor to be entered directly without including the 10-10 factor. The 
resulting unit is termed the Practical Unit (PU).  This same unit is obtained from the Square 
Law by using milli inch w.g. (thousandths of an inch w.g.) and kcfm (thousand cubic feet of air 
per minute). 
 
To ease input of friction factors, a user defined list of k factors may be accessed by clicking the 
Select K Factor button on the Branch Data dialog box.  The Select Friction Factor dialog box 
will appear as shown below in Figure 6.  Use the selection pointer and left mouse click on the 
desired cell and press OK.   
 
This feature allows the user to enter a k factor value and description for each airway type; which 
can be recalled rapidly to be entered into the branch input data sheet. This user-defined list is 
also available from the Branch Input screen.  By selecting the k-factor under the Type drop down 
menu for a desired branch then double clicking the Friction Factor cell, the Select Friction Factor 
dialog box will appear.   
 

 
Figure 6: Friction Factor Dialog Box 

 
3.3.1.4 Resistance per Length Data Form 
 
Data type 4 requests the user to input resistance per unit length (R/L) values for main airway 
types, length and equivalent length of shock losses. Typical resistance per unit length values for 
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the airways being modeled should be obtained from survey results or empirically computed 
using suitable friction factors and airway geometry. 
 
Resistance per length (R/L) values are entered similar to the k-factors discussed in the previous 
section.  R/L values can be entered in both the Schematic view and Branch Input screen.  In the 
Schematic view, R/L values can be entered by pressing the Select R per L button on the Branch 
Data dialog box and selecting a value from the user define list in the Select Resistance per 
Length dialog box as shown in Figure 7.  Also, the Select Resistance per Length dialog box will 
appear by double clicking on the cell under the Resistance per Length header in the Branch Input 
screen.  Resistance per length values are input per 1,000 units (ft or m).  
 

 
Figure 7: Resistance per Length Values Dialog Box 

 
3.3.1.5 Automatic Length Tool 
 
The VnetPC program incorporates an automatic length tool. This feature is accessed from the 
Tools drop down menu in the Model Information, Branch Input, Branch Results, Junction Data 
and Schematic Views. When the user selects "Auto Length" the Automatic Branch Length 
Calculation dialog box is displayed as shown on the following page in Figure 8. 
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Figure 8: Automatic Branch Length Dialog Box 

 
The top section of the dialog box sets the default for any new branches added to the network. If 
the automatic length feature is enabled, then the program will calculate the branch length based 
on the x, y and z coordinate data. The length is calculated for data types 3 and 4 branches only 
(friction factor and resistance per length). The program assumes that each division (coordinate) 
in Imperial Units is 1 ft and in SI Units is 1 m. The user cannot change this within VnetPC, so it 
is important that the correct units be specified in the source program for the DXF import file. 
 
The second section of the dialog box allows changes to be made to existing branches. The 
default is set to "Make no changes." If the user selects to enable the automatic length feature, 
then the length and resistance of all existing branches (specified as data type 3 or 4 {friction 
factor or R/L}) will be computed and changed (using coordinate values). Enabling the automatic 
length feature will result in the length column in the Branch Input View and the length cell in the 
Branch Data dialog to be "read only." The length data cannot be changed unless the user selects 
to disable all existing branches. 
 
During unit conversion, the length of the branches will be converted automatically.  The 
coordinates in the Schematic View will also be converted; hence the automatic length feature 
will provide new length data. 
 
The automatic length tool will update the branch length when there has been a change in the 
location of one of the junctions, or if the branch junction numbers have been reassigned.  
 
3.3.2 Branch Input View 
 
In the Branch Input view, the branch characteristic data can be entered and modified in a manner 
typical of Windows-based spreadsheets. A branch can be added, deleted, or inserted by selecting 
the command under the Branch menu. 
 
If a new model is being developed, or branches are being added, the user can select Add Branch 
under the Branch menu. When the first branch in a network has been entered additional branches 
are added automatically by typing Enter at the end of the last row in the Branch Input View. 
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Additional branches may also be added by typing Shift-Enter at any point in the Branch Input 
View.  
 
Once data has been entered in a particular cell the user can press either the Enter key or the Tab 
key to progress to the next cell.  This section allows the user to enter a description about each 
branch, allocate one of six ventilation symbols to the branch, enter a branch code for the type of 
branch, and specify surface status. The columns in all tabular views may be frozen, hidden or 
shown using tools under the View menu. Figure 9 shows an example Branch Input View. 
 

 
Figure 9: Branch Input View 

 

In the Branch Input view the Find option may be used under the Edit menu or via the Find 

Branch icon (binoculars ) on the tool bar. These tools are different. The Find option seeks up 
or down a selected column for an input text string. The Find Branch option allows branches to be 
located either by entering from and to junction numbers or by finding the next occurrence of a 
particular junction number.  The Replace option allows the user to make global changes to the 
input data. 
 
3.3.3 Schematic View 
 
VnetPC 2007 now features a reversal function, which signals when airflow in a particular airway 
has changed direction from that which was intended.  In order for this function to work properly, 
the user must define each branch with junctions set up in the proper order (similar to fans and 
fixed quantities).  Once a simulation is executed, reversed airways will be tagged, as shown in 
Figure 10. 
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Figure 10: Example airways. 

 
If desired, the ventilation network may be developed entirely within the Schematic View. 
Networks are established using functions obtained from the Tools menu or Tools Bar. This menu 
allocates different functions to the selection pointer. The following list of functions is available: 
 

 Selection Pointer 
 Create Junction 
 Create Branch 
 Plot Existing Junction 
 Create Fan 
 Create Contaminant 
 Create Label 
 Zoom Tool 
 Eraser Tool 
 Edit Tool 
 3D Spin Tool 

 
The Selection Pointer is the default option. This allows the user to highlight branches and by 
pressing the right mouse button change the attributes of those branches. The network may also be 
resized or adjusted by dragging nodes around the screen using this pointer. 
 
The Create Junction option allows new junctions to be created prior to branch entry. The 
branches may then be inserted between the junctions using the Create Branch option. The 
creation of junctions is normally not necessary, because branches drawn in blank areas of the 
screen (using Create Branch) will automatically be assigned From and To nodes and numbers. 
These default numbers can be changed as required. Use of the Create Junction tool is generally 
restricted to the addition of nodes to identify shafts, raises and ramps. The user cannot create 
nodes in the section views. Nodes can only be input in the plan views. A branch may then be 
created between these existing nodes in a section view. Note that the user can select Junction 
Creation under the Tools Menu to change the starting node number (refer to Section 3.3.3.3). 
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The Create Branch tool allows new branches to be drawn. The program automatically allocates 
junctions at the start and end of these branches, unless the user clicks on an existing node or 
intersects an existing branch. If an existing airway is used for a starting or termination point, then 
the branch will be divided and a new node will be added. The divided airway will be represented 
by one branch with the original branch data details, and a second new branch set at zero 
resistance. 
 
The Plot Existing Junction tool allows the user to plot the locations for junctions entered in the 
Branch Input View. This tool will not allow new junctions to be added, and just allows existing 
junctions to be plotted. 
 
The Create Fan tool allows fans or fixed quantity values to be allocated to existing branches. If a 
fan or fixed quantity already exists in the selected branch, then the fan or fixed quantity attributes 
for that branch are displayed. The direction of flow is based on the From/To node input data.  By 
selecting a branch with the Create Fan tool the following dialog box appears, shown in Figure 
11.  The user is then allowed to select a fan or fixed quantity for the assigned branch.   
 

 
Figure 11: Create Fan Dialog Box 

 
The Create Contaminant feature is handled in a similar fashion as the fan tool. In this case a 
dialog box will appear, illustrated in Figure 12, which requires the user to input either a 
contaminant volume flow or a concentration. The input concentration represents the 
concentration of the emission at that point in the airway. The user should not enter the total 
contaminant concentration, which will include any upstream sources. The output contaminant 
flow and concentration (evaluated by the program) will integrate all of the sources to determine 
actual concentration and volume based on a steady state condition. 
 

 
Figure 12: Branch Contaminants Dialog Box 
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The Create Label option allows labels to be entered for specific views or groups (layers). 
Attributes for these labels may then be changed using the Selection Pointer and the right mouse 
button or the Edit Tool. All the common Windows fonts are supported, and the text size may be 
adjusted over a large range for individual labels (see Figure 13). The orientation of the label can 
also be rotated through 360°. The user is allowed to specify a default text font and size (under the 
Preferences Menu/Default Font). 
 

 
Figure 13: Edit Label Dialog Box 

 
The Zoom Tool allows the user to resize the view rapidly. A section of the network may be 
expanded by dragging the mouse over the selected area while holding down the left mouse 
button. The user can also press the left mouse button to zoom-in, or the right mouse button to 
zoom-out. Tool buttons in the Schematic View also enable the user to zoom-in/out  and 
zoom all . These buttons are typically required to allow zooming when using a different tool 
for the mouse (such as Add Branch tool or similar). 
 
The Eraser Tool allows the user to rapidly remove unwanted objects from the schematic. The 
tool will work with branches, nodes and text. A detailed Undo/Redo option ensures that erased 
data may be recalled in the event of a mistake. 
 
The Edit Tool allows the attributes of existing objects to be amended. The user must select the 
required node, branch or text to obtain the properties of the object. 
 
3.3.3.1 Levels and Perspective 
 
VnetPC has been developed to allow networks to be constructed in both the Schematic and 
Branch Input Views. The Schematic View allows the user to develop 3D models using a level 
scheme.  A level in VnetPC is defined as a group of branches falling within a user-specified 
range of z coordinates (may be thought of as a "Group" of branches that span a defined z range).  
It is recommended that the user initially specify a series of levels to cover the entire vertical 
extent of the network. The levels can be established with overlapping z ranges, such that a shaft 
or ramp level would represent a group of branches spread across the entire vertical extent of the 
mine.  
 
By selecting Groups under the Tools drop down menu the user can add, edit, or delete groups 
from the network in the Branch Groups dialog box as shown in Figure 14.   
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